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Overview

AGNS - A Game of Naval Strategy    is a game of naval warfare which you play against the computer.    
While it is not a simulation, the units represented in AGNS loosely resemble naval units which fought in 
World War II.    Your objective is to sink the computers units or capture his main base.    Naturally, your 
Computer Opponent will be trying to do the same to you!

You begin the game by selecting the Game Options and placing your units on the game board.    The game
board is a 12 x 12 grid upon which the game is played.    After the Setup Phase is complete you play the 
game in turns.    Each turn consists of the following phases:

Plot Movement Phase
Air Combat Phase
Movement And Combat Phase
Air Strike Return Phase
Repair/Build Phase

This sequence is repeated until you or your computer opponent achieves victory.



Menu Options

File

New Game - Click this option to start a new game.

Save Setup - After you complete a setup, but before clicking the Done button, you can save your setup.    
Setup files use the file extension .SUP

Save Game - Click this option to save the game you are currently playing.    You can save a game at any 
time during the Plot Movement Phase.    Save Game files use the file extension .SAV

Load Saved Game - Click this option to load a game you have saved.

Load Saved Setup - You can load a previously saved setup and then modify it before starting a new 
game.

Quit - Click this option to quit AGNS.

Options

You can change most of the Game Options during the game.

Help

You can access Help by clicking Help on the Menu Line or hitting the F1 key.



Message Box

Consult the message box for instructions on what to do and for status updates during the course of the 
game.



Game Option

Level

The Game Level determines how well the computer opponent (CO) plays.    The Ensign level is the 
lowest and the Admiral level is the highest.    

Balance

You can balance the game in favor of yourself or the CO.    Balance affects the number of points allocated 
during the initial setup, the number of build/repair points received each turn and the number of aircraft 
that can be built each turn.    Balance also slightly affects Random Events.

View

There are four possible views in AGNS:

Full - All CO units are displayed.

Show Known - All known CO units are shown.    The location of unknown CO units is displayed by the 
unknown icon.

Location Only - CO units are displayed by the unknown icon.

Hidden - Only CO units adjacent to your units are displayed by the unknown icon.

During air or surface combat, the CO units which engage in combat are revealed regardless of the view 
option.    CO submarines are also displayed if they engage in combat; otherwise, they are not displayed.

Size

This option    determines how many points and units are available at the beginning of a new game.    Once 
the initial game options are selected, the size cannot be changed.

Speed

The speed affects how long messages and ship movement direction arrows are displayed.

Additional Options

Sound On - You can toggle game sound effects on and off.    If you do not have a sound card, this option 
will be ignored.



Random Events - If this box is checked, good as well as bad things can happen to you or the CO!

Ship Names - If this box is checked, you can assign names to your Carriers, Battleships and Cruisers.    
Otherwise, the computer will automatically assign each unit a name.



Unit Types

Main Base - Holds up to 12 aircraft.    If captured by enemy transport, the owning player looses the game.
Ships adjacent can be repaired.    Newly built aircraft and ships are respectively placed on or adjacent    to 
the Main Base if space is available.    Can be bombarded by enemy aircraft, battleships and cruisers.

Island Base - Holds up to 8 aircraft.    Can be captured by enemy transport.    Ships adjacent can be 
repaired. Can be bombarded by enemy aircraft, battleships and cruisers.

Aircraft Carrier - Holds up to 6 aircraft.    Requires 6 hits to sinks.    Shoots at 2.

Battleship - Can bombard enemy bases.    Requires 10 hits to sink.    Shoots at 6.

Cruiser - Can bombard enemy bases.    Requires 6 hits to sink.    Shoots at 4.

Submarine - Can only be attacked by enemy destroyers or submarines.    Requires 2 hits to sink.    Shots 
at 4 against all targets except destroyers against which it shoots at 2.

Destroyer - Requires 3 hits to sink.    Shoots at 2 against all except submarines against which it shoots at 
4.

Transport - Can invade base.    Requires 2 hits to sink.    Does not shoot.

Mine - Cannot move or attack.    Automatically destroyed when attacked by enemy mine sweeper.    When
other ships attempt to attack a mine, the mine can do up to 4 points of damage to the attacking unit.

Mine Sweeper - Automatically destroys enemy mines it attacks.    Requires 2 hits to sink.    Shoots at 1.

Aircraft - Can be assigned to Combat Air Patrol (CAP) or to an Air Strike.    When assigned to CAP, the 
aircraft defend all friendly units within a range of 2 of their base.    When assigned to air strike, can move 



up to 6 squares (horizontally or vertically) and attack all enemy units except mines and submarines.    At 
the end of an air strike, must have sufficient remaining movement to reach a friendly base; otherwise, the 
air strike is automatically ditched.    Requires 1 hit to destroy.    Shoots at 1.

Unknown Computer Opponent - Unknown CO units (including mines) are displayed by this icon.    CO 
submarines are displayed only when they engage in combat.



Effects Of Damage

As ships are hit they accumulate damage which in turn decreases the number of shots they can fire.    

When damage reaches a certain level, the ship will sink (see Unit Types for hits to sink).

When bases are hit by bombardment or air strikes, they also receive damage.    Each point of damage a 
base receives reduces its aircraft capacity by one.    If, at the end of combat, a base has received damage 
and there are more aircraft on the base than it can hold, the excess aircraft are eliminated.



Setup Phase

During the Set Up Phase, you select and place units anywhere in the bottom five rows of the playing 
board.    The CO will place his units in the top five rows.    No unit can start the game in the middle two 
rows.

The Set Up Selection Box is used to select which unit you wish to place.    To place a unit, first 
click the option button next to the unit type you want to place.    Then click on the playing board where 
you want to place the unit.    Continue this process until you have placed all the units you wish to.

If you want to remove a unit you have already placed, just click on the unit on the board to remove it.

The Set Up Selection Box show the total number of points you have and the maximum number of
units you can place.    This is determined by the Size and Balance Options you selected.    As you place or 
remove units the Point/Units Remaining will automatically adjust. 

You must place your main base.    There are no other restrictions on the units you place other than the 
limits on certain units shown in the Set Up Selection Box.

When you are finished your set up, click the Done button to start the game.    Note that you can save your
set up by selecting the Save Setup option from the File Menu.    You must do this before clicking the 
Done button.



Plot Movement Phase

During the Plot Movement Phase, you issue movement orders to your units and conduct air operations.    
First select what you want to do by clicking the appropriate option button in the Plot Moves Box and then
performing the actions.

Ship Operation

Move Ship - To Move a ship, first click on the ship in the playing board you want to move.    When you 
do this, the message box will display information about the ship.    Then click on the square you want the 
ship to move to.    All ships can move 1 square horizontally or vertically.    Diagonal movement is not 
permitted.    Move orders are shown in the message box where:

0 - no move order for the ship
1 - move up (north)
2 - move right (east)
3 - move down (south)
4 - move left (west)

To cancel a ships movement order, simply click on the ship two times (not a double click).

Move Task Force - To move a task force, first click on the flagship of the task force.    Then click on the 
square you want the flagship to move to.    All ships assigned to the task force will be given movement 
orders to move in the same direction as the flagship.

Flagship - Use this option to designate a ship as a flagship.    You must do this first in order to create a 
task force.    With the Flagship option selected, simply click on the ship you wish to designate as a 
flagship.    The message box will update and tell you the name of the Task Force for the flagship.    You 
cannot have more than 7 flagships at any one time.

Clicking on the Flagship of an existing task force, disbands the task force.

Attach to TF - Use this option to attach a unit to a task force.    First click on the unit you wish to attach.   
Then click on the flagship of the task force you want to attach to.    Any ship within a range of 2 of the 
flagship can attach to a task force.

Detach from TF - With this option selected, simply click on the ship you wish to detach from the task 
force.

Show Moves - With this option selected simply click on a unit to show its move order.



Air Operations

When the Air Operations option is selected, you can conduct air operations at your bases and aircraft 
carriers.    To conduct air operations click on a base or carrier.    A pop-up window will appear showing the
status of the base or carrier and aircraft.    Aircraft at a base or carrier can be in the following states:

Ready - Ready aircraft can be moved to CAP or an air strike.
Air Strike - Aircraft in this state can be moved during the Air Combat Phase.
CAP - Aircraft assigned to CAP will defend friendly units (not mines and submarines) within a 
range of two of their base.    CAP remains up until it is landed.
Refueling - Planes returning from an air strike must spend the next turn refueling before they are 
automatically moved to Ready status.    Landed CAP must also spend a turn refueling before they 
become Ready.
Landing - This box shows planes returning from an air strike or landing CAP.

Click the arrows between the boxes to move aircraft from one state to another.    Use the left mouse 
button to move one aircraft at a time.    Use the right mouse button to move all the aircraft.

If you hit the Cancel button, all orders will be ignored.    Hit the OK button to put your order into effect.   
Once aircraft orders are put into effect, they cannot be change.

The Show Button

Use this button to highlight a task force or your flagships.    When you click this button, a pop-up will 
appear.    Use the pop-up to select what you want to highlight or to cancel highlighting by selecting the 
None option.

The Done Button

Click the Done button when you are finished giving ship move order and conducting air operations.    The 
game will move on to the air and surface combat phases.



Air Combat Phase

During this phase, air strikes are conducted.    Player air strikes are done first followed by CO air strikes.

Your air strike will appear over your base or carrier.    To move the air strike, click on the square you want 
the air strike to move to.    Like ships, air strikes can move only horizontally or vertically.    If you click
on a square containing an attackable enemy unit, air combat will take place.

If there is any CAP protecting the unit being attacked, the CAP will first attempt to shoot down the 
attacking planes.    If any attacking planes remain after engaging the CAP, they will attack the enemy unit 
and end their movement in the square occupied by the enemy unit.

You are not required to attack with an air strike.    You can end the air strikes movement at any time by 
clicking the Air Strike Done button.

REMEMBER: Your air strikes can only move a total of 6 squares.    You must leave enough movement 
to return to a base that has sufficient capacity for the returning air strike.    Also, be careful about moving 
your aircraft carriers to far away from the air strike.



Movement And Combat Phase

During the movement and combat phase, ships move and fight according to their orders.    The computer 
randomly selects ships to move.    If a ships movement is blocked by another friendly ship, the computer 
will skip the blocked ship and come back to it later and try to move it again.

Movement is shown on the playing board and combat results are displayed in the message box.

When a ship attempts to move into a square occupied by an enemy ship, surface combat occurs.    The 
attacking ship shoots first and then the defending ship shoots.    If the defending ship is sunk, the attacking
ship will move into the square occupied by the sunk defender.

Battleships and Cruisers can attack bases by attempting to move into the square occupied by the base.    
When this happens, the base is bombarded.    Hits by the attacking ship are registered as damage against 
the base.

Transports represent invading forces.    They can capture an enemy base by plotting a move on to the 
base.    When an enemy base is captured, control of the base reverts to the capturing player.    All aircraft 
on the base are destroyed.    The captured base becomes immediately available for landing planes and 
performing ship and base repairs.    Capture of the opponents Main Base ends the game.



Air Strike Return Phase

During this phase you return your air strikes to bases.    Each air strike will be displayed and the message 
box will instruct you to click on the base or carrier you want the air strike to land on.    If you click on a 
base within the air strikes remaining movement allowance, a pop-up will appear.

To land aircraft on the selected base, click the arrow.    Clicking the left mouse button causes one plane to 
land.    Clicking the right mouse button cause all the planes to land if there is base capacity for all the 
planes. 

If you hit the Cancel button any landing you ordered will be canceled.    Click the OK button to confirm 
the landing.

If an air strike cannot land at ANY base within its remaining movement it must be ditched.    Use 
the Ditch Remaining Aircraft button to perform this operation.



Repair/Build Phase

During the Repair/Build Phase you use your repair/build points to repair damaged ships and bases and 
build new ships and aircraft.    The points available for performing these functions are shown in the upper 
right hand corner of the Repair/Build box (e.g. 14 points in the example shown to the left).    The cost of 
performing various repair/build functions is shown next to the function.    For example, it costs 3 point to 
repair a base or ship.    It costs 12 points to build an aircraft and 30 points to build a submarine.

Repair Base - With the Repair Base option selected, simply click on the base you want to repair.    You 
can repair one point of damage per turn.

Repair Ship - With the Repair Ship option selected, simply click on the ship you want to repair.    You can
repair one point of damage per turn.    To be eligible for repair, the ship must be in one of the 8 squares 
surrounding any friendly base.

Build Aircraft - New aircraft can only be built at the Main Base.    There must be space available to hold 
the newly built aircraft.    With the Build Aircraft option selected, simply click on your main base to build 
the aircraft.    The number of aircraft that can be build in a turn is dependent on the size of the game and 
the game balance.

Building New Ships - Any repair/build points that are not used to repair bases, repair ships, or build 
aircraft are applied to building the ship type you select for building.    For example, in the picture shown 
to the left, the player is building a submarine.    14 points have been applied to the building of the 
submarine.

When a new ship is finished, the computer will prompt you to place the new ship next to your Main Base. 
There must be an empty space next to the Main Base for the new ship to be placed.

Click the Done Repair/Build button to end the Repair/Build Phase.



Victory

Victory is achieved when:

1.    The Player or the CO achieves a strength ratio of 3.
2.    The Player or CO invades (capture) the opponents Main Base

The CO can also win at the Admiral and Captain level by inflicting 12 points of damage on the Players 
Main Base.

When you or your CO achieve victory, you will have an opportunity to record your victory in the AGNS 
Hall of Fame!



Registration

ORDER FORM
AGNS - A Game of Naval Strategy

ONLY $14.95(US$)    
 

AGNS is sold as Shareware. This means that you get to Try Before You Buy - a good deal!    
Shareware authors spend hundreds of hours developing their products.    If they succeed in 
developing a quality product that you find useful or enjoyable, they deserve to be compensated 
for their work.    This way everybody wins because the shareware authors (if they are good!) will 
continue to develop quality products and you, the consumer, benefit from value offered by 
Shareware (we can sell our products at very reasonable prices because we have low marketing 
costs).    So, if you think AGNS is a good product and you find yourself playing it, please register!
When you resister, you will:

-Receive instruction to fully enable the program
-Be eligible for free upgrades
-Be eligible for technical support

Customer Name:__________________________________________________

Address/Apt: __________________________________________________

City/State/Zip: __________________________________________________

Country :                    __________________________________________________ 

E-Mail Address: __________________________________________________ 

Price (US$): $14.95    Connecticut residents please add 6% sales tax.    For your convenience, 
this form is included in your installation directory as file Order.wri.

CHECK OR MONEY ORDER

Mail this order form along with check or money order payable in US funds, and drawn on a
US bank, to K.I.S. Software, 47 Sunnybrook Drive, Avon, CT 06001.

COMPUSERVE REGISTRY

If you are a member of Compuserve, you can register using the Shareware Registry (GO 
SWREG).

CREDIT CARD (VISA or Master Card)

- In the US or Canada by calling (800) 300-3589 (M-F, 8 a.m. - 9 p.m. Eastern time)
    - Complete the order form (Order.wri) and FAX to K.I.S. Software at (860) 675-9470

- Internet: E-mail order form (Order.wri) 74067.2102@compuserve.com
                - Compuserve: E-mail order form (Order.wri) to    74067,2102
              - America On Line: E-mail order form (Order.wri) to MStradley
                - Mail order form    to K.I.S. Software, 47 Sunnybrook Drive, Avon, CT 06001



Card Type: MC          VISA          (Circle One)      

Name as it appears on card: ________________________________

Card Number: ________________________________

Expiration Date: ________________________________

Important Note: Visa/MC charges will appear as Connecticut Created on your statement



Hints

Strategic

Strategically AGNS is a game of position.    Initial placement of your units plays an import role in 
determining the final outcome.    Always place your bases so that aircraft can be shuttled from the Main 
Base (where they are built) to Island Bases.    Another important consideration is how far forward to place 
you bases.    If they are too far forward, they are vulnerable to attack by the CO.    However, if they are too
far back, they cannot provide CAP support for your ships and re-supply of new aircraft for your carriers.   
Ship repair also becomes a problem as your damaged ships have to make long transits to the bases for 
repair.

When placing and moving your ships, formations should be built around aircraft carriers.    As these 
formations move forward, the carriers can provide CAP protection for the ships and the surrounding ships
protect the carriers from air attacks and direct assaults by enemy ships or submarines.

Tactical

Just a few hints to get you started.    One of the fun things about AGNS is developing your own tactics.

Keep a good supply of destroyers handy.    They are relatively cheap and very effective against 
submarines.    Theres nothing worse than having an enemy submarine running around in your formation 
with nothing available to take it out.    Destroyers (as well as Mine Sweepers) are also excellent scouts 
when playing the Hidden View option.

When you are playing the Hidden View option (the most difficult), form air strikes of one aircraft to scout
ahead of your main battle formations.    They can be used to detect enemy units without actually attacking 
them.

Bombardment of enemy bases by aircraft, battleships or cruisers is usually necessary.    If you try to run a 
transport up to a base that is heavily stocked with aircraft, it will likely be taken out before it has a chance
to invade.

Be judicious in making air strikes.    Planes are expensive to replace.    Look for spots where enemy CAP 
coverage is expected to be light.



Contacting Us

If you have any problems installing AGNS or if you experience any problems playing the game you can 
contact us through any of the following:

Mail: K.I.S. Software
47 Sunnybrook Drive
Avon, CT 06001

FAX:                            860-675-9470
AmOnLine:          MStradley
CompuServe:    74067,2102
Internet:                  74067.2102@compuserve.com

Comments and suggestions are always welcome!



In AGNS, range is always measured in terms of horizontal and vertical squares.



The strength ratio is the ratio of the Computer Opponent strength to the Player strength.    It is displayed 
in the upper right hand corner of the Plot Movement Box.    For example, a strength ratio of 2 means that 
the CO has twice as much strength (ships, bases, planes) as the Player.    Conversely, a ratio of 0.5 means 
that the Player has twice as much strength as the CO.



Quick Start

To get an initial feel for AGNS you may want to load the sample setup supplied with the game.    From the
File Menu, select Load Saved Suetup.    Then select file sampsmal.sup.    The sample setup will load.    
You can change the setup by clicking on units to delete them and then selecting other units in the ship 
selection box and placing them in the bottom five rows.    When finished, click the Done button to start 
the game.

To get a feel for the play of the game, try the following:

1. Select the Flagships option and then click one of your ships to make it a flagship.    Then click the 
Attach to TF option and attach one or two ships to the task force.    Remember that the ships have to 
be within a range of two of the flagship.    Click the Show option and select the task force to 
hightlight the task force.    Then move the task force by selecting the Move Task Force option.

2. Select the Move Ship option and give some move orders to individual ships.

3. Select the Conduct Air Operations option.    Then click on a base or carrier.    When the pop-up 
appears, move some aircraft to CAP and then move a plane or two to air strike status so that you can 
practice moving the air strike during the Air Combat Phase.

4. Select the Show Move option and then click on a ship to see the ships move order for the turn.

5. You may also want to adjust the Game Speed using the Options Menu.

6. While you are in the Options menu, you can also change the View Option.

7. While you are doing all this watch the message box. 

8. When you are finished, click the Done button and watch the ships move.    If you have made an air 
strike, you can practice moving the air strike.

9. If you made an air strike and planes survived, they will need to be returned to a base at the end of the 
Movement and Combat Phase.

10. Finally, you will need to designate which ship you want to build at your Main Base during the 
Repair/Build Phase.    At the start of the game you will not be able to repair ships or bases as none of 
your unit will have any damage.    You will also not be able to build any aircraft at you Main Base 
until you have lost some aircraft and moved aircraft from your Main Base to Island Base(s) or 
Carriers to make room for aircraft you want to build.

Play several turns until you get a good feel for the game and all the option you have!




